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3D Slicer is...

3DSlicer

*An end-user application for
image analysis and
visualization

* An open-source environment
for software development

- A software platform that is
both easy to use for clinical
researchers and easy to
extend for programmers
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& www.slicer.org

3DSlicer

E 5 . A multi-platform, free and open source
~\‘ 3DSlicer visualization and medical imag

3DSlicer version 4 is [
a multi-platform T
software running on
Windows, Linux,
and Mac OSX.

Disclaimer

It is the responsibility of the user of 3DSI|cer to comply W|th both the
terms of the license and with the applicable laws, regulations and rules.
Slicer is a tool for research, and is not FDA approved.
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_ @ www.slicer.org

3DSlicer
* This workshop uses @ oslicer S ——

a new pre-release of | o)) ) s s

3D Slicer version 4

* Visit the Slicer
download page for
Slicer 4 official
release, or Slicer
nightly builds.
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\ Tutorial Overview

3DSlicer

» Getting Started: Slicer4 Minute Tutorial

* Quantitative Measurements for Functional Imaging:
PETCT Fusion Tutorial

* Quantitative Measurement of Volumetric Change:
Change Tracker Tutorial

All Tutorial datasets are located in
C:\Documents and Settings\Administrator\Desktop
Slicer_data 2011
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B

Launch the Application

& 3D Slicer 4.0.gamma-2011-11-14

=S

3DSlicer
File Edit View Help
@R & Modues: Welcome to Slicer S| -

® ®

AR N S A

EE & 4 v persistent o S

@ Slicer
Welcome

Yy S
[Gicowy Load DICOM Data [Barsy Load Data
»,
[y Load Volume Data ) pownload Sample Data
> About

» The Main Window

» Loading and Saving
» Display

> Mouse &Keyboard

¥ Tutorials & Information
> Acknowledgment

¥ Data Probe

Windows users: :

Start -> All programs -> Slicer4 -> Slicer
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_@ Slicer4 Minute Tutorial

3DSlicer

Part I: Slicer4d Minute Tutorial

Sonia Puijol, PhD
Wendy Plesniak, PhD

This tutorial is a short introduction
to the advanced 3D visualization
capabilities of the Slicer4 software
for medical image analysis.

It is designed to quickly build a
basic level of comfort with the
Slicer software.
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Slicer4 Minute Tutorial

3DSlicer

The Slicer4 Minute dataset is composed of
An MR scan of the brain and 3D surface
Reconstructions of anatomical structures.

The data are part of the SPL-PNL Brain Atlas
Developed by Talos et al. The atlas is available at:

http://www.spl.harvard.edu/publications/item/view/1265
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Slicer4 Minute Tutorial: Navigating the Application GUI

Ve
3DSlicer
[ 3D Slicer 40.gamma-2011-11-14 L. X e . X . N (o] E [
File Edit View Help
.- .. ...Menu&Toolbar . _ ..
. 1

The Graphic User CRE

> Help & Acknowledgement

Interface (GUI) of Slicer4
integrates four

3D Viewer

components:
* the Menu Toolbar Module GUI |
* the Module GUI Panel Panel

* the 3D Viewer
* the Slice Viewer

RSNA 2011 Slide 9



@

3DSlicer

The SlicerWelcome
module is the module
displayed by default.

This module gives an
overview of the GUI of
Slicer4, and data
loading & saving
functionalities.

Slicer4 Minute Tutorial: Welcome Module

& 3D Slicer 40.gamma-2011-11-14

(=] E -

RSNA 2011

File Edit View Help

Modules: Welcome to Slicer

om B

@ Slicer
Welcome

[Gistay Load DICOM Data

Yy
[fowune/ Load Volume Data

Yy
[oata_y Load Data

) pownload Sample Data

> About

» The Main Window

» Loading and Saving
» Display

> Mouse &Keyboard

» Tutorials & Information

> Acknowledgment

» Data Probe

Ov DO @ A9 4 | § v [ persistent Ao Ra, -
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3DSlicer

Click on the Load Scene icon

Browse to the location of the
Slicer_data directory.

RSNA 2011

Slicer4 Minute Tutorial: Load a Scene

[ £ 3D Slicer 40.gamma-2011-11-14

T4, View Help

Welcome to Slicer

[
‘ R & | Modules:

@ 3DSlicer
Welcome

| iy Load DICOM Data ||

[ty loadData |

‘ @ Load Volume Data H 9 Download Sample Data‘

dm 00 IN® e 4 @9H 2B

@®

> About

P The Main Window

» Loading and Saving

» Display

» Mouse &Keyboard

¥ Tutorials & Information

P Acknowledgment

¥ Data Probe

L
E
B

0’ t v || Persistent

] Open

Look in: ‘ @ C:\Users\BIDMCvostro\Dropbox\RSNA\Slicer_data

000 [EE

»‘I‘HV BIDMCvostro 6 ChangeTracker2010
C} PETCTFusion-TutorialData

! . "
) Slicer3Minute

File name:

Files of type: ‘ All (*.mrml *,xml *.xcat)
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@ Slicer4 Minute Tutorial: Load a Scene
4

& 3D Slicer 4.0.gamma-2011-11-14

3DSlicer

File Edit View Help

@®

@ 3DSlicer
Welcome

Browse to the location of e QJLZZM
the Slicer3Minute dataset

directory.

Select the scene file
slicer3minute.mrml

Click on Open to load the
scene

2\@ &) Modues:  |Welcome to Sicer s ;v QO O Q QO & A W E 7 E E $ v [ Ipersistent @ %= &v v
1

(L0 o]

it | g CiWUsers\BIDMCvostro\Dropbox\RSNASicer_data\Slicer Minute Q00 EHE
1|} BDMCvostr) @ eeeeeeeeeeee el

RSNA 2011
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@ Slicer4 Minute Tutorial: Viewing the Scene
=4

3DSlicer

E 3D Slicer 4.0.gamma-2011-11-14

File Edit View Help

= 5 Modules: Welcome to Sicer

[B) osice:
When the scene is finished loading,
Slicer displays:

°a 3D model of the head in the 3D |

Viewer, and
*anatomical MR slices of the
brain in the 2D Slice Viewers.

RSNA 2011

2D Slice Viewers
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\ Slicer4 Minute Tutorial: Viewing the Scene
i

3DSlicer

llllll

Welcome

[EC Load Data

|| [Bieawy Load DICOM Data

Note:

We have pre-adjusted the window and level
settings for these volumes so that they are
appropriate for display on most laptops.

If display is not satisfactory on your machine
or projector, the Volumes Module may be
used to refine these settings.

I Q00N O @
AN L

(21E ]

AGHE 2 B ¢t e R Re
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@ Slicer4 Minute Tutorial: Exploring Slicer’ s functionality
-

3DSlicer [ 3D Slicer 40.gamma-2011-11-14 = S
File Edit View Help
A‘:‘p{ & Modules; Welcome to Slicer 5
All Modules 4 i@ ®

[£] Annotations
lb\ 3fslighr DICOM
4 A Data
/. Editor

Left click and hold the elE=_
Modules menu button. e e

OM Data )
b @ \Volume Rendering
ume Data e Volumes

1 Welcome to Slicer

Select All Modules to [

Informatics

display the many modules s

available for image -
processing, analysis and 3D | <

tion Converters

visualization. |

Developer Tools

T

T

Legacy
¥ Data Probe Testing

RSNA 2011 Slide 15



3DSlicer

To access the Models
module, browse
through the list of
modules...

...or click on the

models icon ©
in the toolbar

RSNA 2011

3D Slicer 4.0 gamma-2011-11-14 ACPC Transform
Fle Edt View Help Add Images
r 1 Annotations
R B |Moddes: [ wekcome to sicer $
] BSpline to deformation field
@ Cameras
[Z Annotations Cast Image
(B sosiicer DICOM ChangeTracker
& . Data CheckerBoard Fitter
/. Editor B Colors
Welez=, e
Fa Scene Views & Crop Volume
N Curvature Anisotropic Diffusion
srorms
View Controllers pream
“Caa DICOM Data DWI to Full Brain Tractography
Volume Rendering
@ Load Volume Data| @ Vol A pet2
Load Volume Data lumes
DataProbe
Welcome to Siicer
Dicom to Nrrd Converter
[» about Wizards Diffusion Tensor Estimation
Informatics Diffusion Tensor Scalar Measurements
| > The Main Window Registration EMSegment Command-ine
] with Atias
»
[ > Loading and saving Quantification [ EMSegmenter without Atlas
== Diffusion 7 Editor
et Endoscopy
| > Mouse & keyboard Fitering Event Broker

| Tutorials & Information

‘ » Acknowledgment

Surface Models

Execution Model Tour

Converters Expert Automated Registration
Endoscopy Extract Skeleton

Utiities Fast Affine registration
Developer Tools Fast Nonrigid BSpline registration
Legacy Fast Rigid registration

Testing Fiducal

¥ Data Probe

 Internet Explorer ca

Foreground masking (BRAINS)
Gaussian Blur

General Registration (BRAINS)
Gradient Anisotropic Diffusion
Grayscale Fill Hole

Grayscale Grind Peak
Grayscale Model Maker
Histogram Matching

Image Label Combine

Intensity Difference Change Detection (FAST)
Joint Rician LMMSE Image Filter
Label Map Smoothing

Label Statistics

Linear registration

#@A

&

icer4 Minute Tutorial: Exploring Slicer’ s functionality

MRI Bias Field Correction

Mask Image

Mask from Diffusion Weighted Images
Median Fiter

Merge Models

Mesh Contour Segmentation

Madalan

Models

TREETE

Multiple models example

Multiply Images

NAITK MRI Bias correction
Orient Images

Otsu Threshold

Otsu Threshold Segmentation
Performance Tests

PolyData To Label Map

Probe Volume With Model (Paint)
Resample DI Volume

Resample Image (BRAINS)
Resample Scalar Volume
Resample Scalar Vector/[DWI Volume
Rician LMMSE Image Filter
Robust Multiresolution Affine Registration
Robust Statistics Segmentation
SUVComputation

Sample Data

Scene Views

Simple 10 Test

Simple region growing

Subtract Images

Test GridTransform registration
Threshold Image

Tractography

Tractography Display

Tractography Fiducial Seeding
Tractography Labelmap Seeding
Transform MRML Fies to New EMSegmenter Standard
Transforms

Unbiased Non Local Means filter for DWI
View Controllers

Volume Rendering

Volumes

Voting Binary Hole Filing

Welcome to Siicer
——

(& 3D Slicer 4.0.gamma.. <l

W& 3150M
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@ Slicer4 Minute Tutorial: Switching to the Models Module

/5 3D Slicer 40.gamma-2011-11-14 (=] 5 [

File Edit View Help

3DSlicer

S B | Modues: € Models

Q- ) {D o ‘% A @ z 7 E o t ¥ || Persistent o ‘;@- v

B o XHSIicer displays the GUI of the

@ [

Models module.

» Help & Acknowledgement

1.00
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\@ Slicer4 Minute Tutorial: Basic 3D Interaction
N

3DSlicer

Position the mouse
in the 3D Viewer.

Hold down the left

mouse button and
drag to rotate the

model.

& 3D Slicer 4.0.gamma-2011-11-14

|5 S

File Edit View Help

/““;{’_ 5 Modules: € Models

@ 3DSlicer

» Help & Acknowledgement

0
@
I
5
[

3999999999
Ln1000

RSNA 2011

P Infort
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ation

¥ Display

L 4

Slide 18



\ Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer
-

3DS|i £ 3D Slicer 40gamma-2011-11-14 (= [ E [
cer File Edit View Help -
B sk Qs ™ QOO @ A PE 2Bt e | @ A R+

@ 3DSlicer

» Help & Acknowledgement

Click on the Slice Visibility .
~| icont

to display the Axial Slice in;
the 3D Viewer

¥ Data Probe
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Slicer4 Minute Tutorial: 3D Visualization

3DSlicer

the Axial slice in the

Slicer adds a view of
3D View.
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3DSlicer

Select the Skin model.

Change the opacity of
the model from
1.0 to 0.0.

Slicer4 Minute Tutorial: 3D Visualization

RSNA 2011

/5 3D Slicer 4.0.gamma-2011-11-14

File Edit View Help

@ 3DSlicer
4

ﬁ ﬁ Modules: ‘ € Models

"-.0.‘) {Do%‘(\@:ﬂ/ ‘;‘tv Persistentakb&v

> Help & Acknowledgement

Scen

¥ Material Properties

L
E
B

Color: O ‘
Opacity: sl =l
Ambient: l0.00 (51 [v)
¥ Data Probe

e v
&
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@ Slicer4 Minute Tutorial: 3D Visualization
y

[ 3D Slicer 40.gamma-2011-11-14 [E=E )

File Edit View Help

ﬁ 5 Modules: @ Models : -v c‘ J Q 0 G A @ E 7 ; t ¥ || Persistent

o [Et
“54‘ 3DSlicer

The model of the skull bone-
and eyeballs become visible
through the model of the skin in
the 3D viewer.

3DSlicer

(skin model opacity = 0.5)

¥ Data Probe
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@ Slicer4 Minute Tutorial: 3D Visualization
y

[ 3D Slicer 40.gamma-2011-11-14 [E=IElx)
3 DS | i cer File Edit View Help
ﬁ 5 Modules: @ Models s = 0 O Q o G A @ E A ‘ o ‘ t ¥ || Persistent E o o o v

@®

!ﬁ; 3DSlicer
Y

» Help & Acknowledgement l“
|

=} Scene

The model of the skin becomes
invisible in the 3D viewer.

(skin model opacity = 0.0)
(skull model opacity = 1.0)

¥ Data Probe

RSNA 2011

Slide 23



3DSlicer

RSNA 2011

Slicer4 Minute Tutorial: 3D Visualization

/5 3D Slicer 4.0.gamma-2011-11-14

File Edit View Help
ﬁ ﬁ Modules:

| @ Modeis

e ® Bl

Click on the Slice
Visibility :
icon in the Green Slice
Viewer

to display the Coronal
Slice in the 3D Viewer.

"-.o.i) QO%A@Z/ ‘E‘tv Persistentakb&v & v

¥ Material Properties

Color: O ‘

Opacity: [0.00 ]

Ambient: ‘E’g{ %
¥ Data Probe ‘

L
E
B

A:0.00
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| |

@ Slicer4 Minute Tutorial: 3D Visualization
4

/B 3D Slicer 4.0.gamma-2011-11-14

File Edit View Help
g & [Modues: | @ Models s| - 0 \‘) DT % A @ Z 7 ‘0‘ £ v [ Persistent o o | 4~

3DSlicer

3DSlicer

The Axial and Coronal
Slices are displayed in
the 3D Viewer.

Acknowledgement
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@ Slicer4 Minute Tutorial: 3D Visualization
e

3DSlicer

Select the 3D
model
skull_bone.vtk in
the Model
Hierarchy and turn
on the Clipping
option.

RSNA 2011

[ 3D Slicer 40.gamma-2011-11-14 = | B )
File Edit View Help
it | Modules: @ Models s = Q ‘) {D © G A @ a 7 o t v || Persistent e 5o N: 4

N

.E 3DSlicer

» Help & Acknowledgement =
|
=} Scene
® hemispheric_white_matter.vtk 1.00
& |eft_ey vtk B 100
> Vi 1.00
* o _L.vi 1.00
* o RV 1.00
& optic_tract_L.vi 1.00
® optic_tract_R.vf 1.00
* right_e v M 100
#_Skin. v 0.00
» Information |
¥ Display |
Visible: v
Selected:
| lip: v

Slice Intersections Visible:

¥ Material Properties

Color:

Opacity:

Ambient:
¥ Data Probe
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@ Slicer4 Minute Tutorial: 3D Visualization
S

& 3D Slicer 4.0.gamma-2011-11-14 =[5 ﬁ:’-]

3DSlicer

File Edit View Help

G Y [voddes: [ @ Modek = Q0 IN® & A §HE 2 E‘ 4 v [ persitent fo fa | 4~

!ﬁ; 30Slicer
v

> Help & Acknowledgement

w
@
I
5
n

# hemispheric_white_matter.v1 1.00
# |eft_eyeball.vi M 100
* o 1.00
= o Vi 1.00
 optic_nerve_R.v 1.00
® optic_tract_L.v! 1.00
 optic_tract_R.vi 1.00
# right_eyeball.v! M 100
- Skin.v! 0.00
» Information |
¥ Display |
Visible: v
Selected:
Clip: v
Slice Inter

rties
Color: |
-

Opacity: 1.00 (4]
Ambient: (o0 4] ¥
¥ Data Probe
L ’
E J.
B

Browse through
the coronal
slices to expose
the 3D model of
the white matter,
and the left and
right optic
nerves.

RSNA 2011

Slide 27




y

3DSlicer

Now make the skull
invisible.

Slicer4 Minute Tutorial: 3D Visualization

RSNA 2011

E 3D Slicer 40.gamma-2011-11-14

File Edit View Help

SR B | Modues:

f !l= 3DSlicer
v

| @ Modeis

d= Q00 IO @ A @@ < HEa]t - @

B®

» Help & Acknowledgement

3

=}~ Scene
# hemispheric_white_matter.vtk 1.00
# |eft_eyeball.vtk M 100
# optic_chiasm.vtk 1.00
® optic_nerve_L.vtk 1.00
# optic_nerve_R.vtk 1.00
® optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
< _ckin vtk 0.00
|  ® skulborewvtk M 1.00 |
» Information |
¥ Display |
| visible:
Selected:
Clip: v
Slice Intersections Visible:
¥ Material Properties
Color: ( J
Opacity: 100 3]
Ambient: [ooo 4] [+
¥ Data Probe
L
F
B
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@ Slicer4 Minute Tutorial: 3D Visualization
y

& 3D Slicer 40.gamma-2011-11-14 [E=EEN )
3 DS | i cer File Edit View Help

ﬂ By | Modules: € Models

@ 3DSlicer
w

» Help & Acknowledgement

Scroll the Coronal Slices to display the]
hemispheric white matter model in the
context of the image data in the 3D
Viewer.
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v

3DSlicer

Select the hemispheric white

hemispheric_white_matter.vtk| :=:5-u

Slicer4 Minute Tutorial: 3D Visualization

E 3D Slicer 4.0.gamma-2011-11-14

File Edit View Help

v@ 3DSlicer

» Help & Acknowledgement

=i Scene

I hemispheric_white_matter.vt 00
matter model called| :z:==- i

# optic_nerve_L.vtk

& optic_nerve_R.vtk

# right_eyeball.vtk o
® skin.vtk
® skull_bone.vtk

» Information

Turn off its visibility. | - ..

| Visible:
Selected:

Clip:

Slice Intersections Visible:
¥ Material Properties

Color:
Opadity:

Ambient:
¥ Data Probe

-

;‘*‘3 5 Modules: @ Models s ;v Qv () e &% A a Z 7 ;‘ £ v [ rersistent 5o &.
@® Bl

RSNA 2011
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@ Slicer4 Minute Tutorial: 3D Visualization

3DSlicer ]

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.
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@ Slicer4 Minute Tutorial: 3D Visualization: Zoom the view
N =

[ 3D Slicer 4.0.gamma-2011-11-14 o | E )

3DSlicer

File Edit View Help

G Modes: | @ Models s = Q. OO % 2@ E 2 &) b v ressent | @ w Fo, M
Windows/Linux users: Position the
mouse in the 3D Viewer, hold down:

the right mouse button and move,~
the mouse down to zoom in.|

" OpUC T AC RV
} ‘ ® right_eyeball.vtk
# skin.vtk
# skull bone.vtk

Mac users: Position the mouse in.
the 3D Viewer, hold down the apple
button and the mouse button and

move the mouse down to zoom in: -

(or use two fingers on the touch :

pad).
)
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\ Slicer4 Minute Tutorial: 3D Visualization: Zoom the view
b 4

3DSlicer 5 3D Slicer 40.gamma-2011-11-14 T

File Edit View Help

B p ks O " QO INO e AGE 2 |E[O] L s | E A | b
@J’DSlicer

| ¥ Help & Adknowledgement

Slicer displays a closery
view of 3D anatomical|- -
structures overlaid on 2D |-
MR slices'™

Visible:
Selected:
Clip:

Slice Ints

Color:

Opacity:

Ambient:
¥ Data Probe
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@ Slicer4 Minute Tutorial: Summary
-

3DSlicer

This tutorial has demonstrated:

» Basic description of the Slicerd4 Application Interface
 How to load a scene containing volumes and models
« How to visualize these different datasets together

Next, we will use these building blocks to perform image
analysis and visualize quantitative results
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_@ Close the existing scene and all its data

3D Slicer 4.0.gamma-2011-11-14

3DSlicer

Clear the previous
scene.

Select File->Close
Scene

This removes any datasets;
previously loaded into!
S|icel’.;" N IS
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[ PET/CT Visualization and Analysis

R S: -740

3DSlicer

Partll: PET/CT
Analysis using 3D Slicer

Jeffrey Yap PhD

Ron Kikinis MD
Wendy Plesniak PhD
Nicole Aucoin BSc
Valerie Humblet PhD
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@ PET/CT Visualization and Analysis: Load the new scene
y

@ 3D Slicer 40.gamma-2011-11-14

3DSlicer [

[ Fie Fdit View Help

L= .
‘ = b Modules: Welcome to Slicer

Click on the Load Scene icon
‘@ 3DSlicer

Welcome

®

Select Slicer_data

Select the PETCTfusion-TutorialData
directory;

And select the scene file:| |
PETCTFusion-Tutorial-Scene.mrml|
double click the file, or click Open

» Data Probe

i Open

d" 0 QN @ s @@ 2 |Ee]t | B A R4~

]

||| BDMCvestro cn

e e e
i

PET2

Results

File name: PETCTFusion-Tutorial-Scene.mrml

Look in: ‘ @ C:\Users\BIDMCvostro\Dropbox\RS..r_data\PETCTFusion-TutorialData = ‘ O ‘) o @ E]

Files of type: ‘ All (*.mrml *.xml *.xcat)

RSNA 2011
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@ PET/CT Visualization and Analysis: About the data

3DSlicer

 Non small cell lung cancer patient

« Two PET studies: baseline acquired before treatment, and
follow-up acquired 1 month after chemotherapy

« Two non-diagnostic CT images are acquired without the use of
contrast

« FDG-PET scans acquired 60 minutes after intravenous injection of
approximately 20 mCi of 18FDG

« Two VOIs have been created using Slicer’ s Editor Module.
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| @ PET/CT Visualization and Analysis: About the data

3DSlicer

Standardized Uptake Value

SUV (time) = Radioactive Concentration x Weight
Injected Activity

« Under certain circumstances, '8SFDG SUV correlates with metabolic rate of
glucose and/or the number of viable tumor cells

« Simplified semi-quantitative measure that can be routinely performed in clinical
PET studies

« Adjusts for differences in patient size and injected activity
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; @ PET/CT Visualization and Analysis: About the data
o

3DSlicer

Response criteria

« Complete response (CR): Complete resolution of all lesions
« Partial Response (PR): >= 25% decrease in SUVmax
- Stable Disease (SD): < 25% change

*  Progressive Disease (PD): >= 25% increase in SUVmax
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@ PET/CT Visualization and Analysis: view the scene

/5 3D Slicer 4.0.gamma-2011-11-22 [P
3DSlicer Fle Edit View Help
S| Modues: Welcome to Sicer Il e % A Eﬁ Z 7 & | v Persistent Be ‘;‘h. -
@ R 3

!“) Slicer

Welcome
To view the slices in S ——
the 3D viewer, click on f © vowreizerc
center the 3D viewon ... -

» Loading and Saving

scene icon T

» Mouse &Keyboard
» Tutorials & Information

» Acknowledgment

¥ Data Probe

-
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&

3DSlicer

Zoom (right mouse
button)

Then click on the Slice
Visibility [~| icon

to display the Axial and
Sagittal Slices in the
3D Viewer

RSNA 2011

PET/CT Visualization and Analysis: Open the Volume Module

& 3D Slicer 4.0.gamma-2011-11-22

==

File Edit View Help

S

Abou
> The Main Wind
P Loading an d Saving
» Display
» yboard

i‘m:m‘, Load DICOM Uata

£ ”
[ Loz Volume Data

Welconie

S

[[Satay Load Data

O Download Sample Data

Q | & | | Axal

O QQ‘%X\@Z/EOtY Perswstemkt-)fth_ v
el —

sm e, -

| & Lo, PET 14abel

@ | 4% |o.00 ={ B |peTt

@ | & = st

S: -740.00 1

R: -54.24 G P A: 103.32

s
i
”';m"/l'v“ )

% \{‘
&

Slide 42



PET/CT Visualization and Analysis: Open the Volume Module

3DSlicer S By |Modues: | welcome toSicer |- O e A § 4 7 E & | v pemsistent fa Ra -

Al Modules ‘e ER

& Annotations | AR . _

_‘ 3DSlicer DICOM @ | # |10 PETicbel
= A\ Data

‘ ) =

@ | < oo m PET1

@

/. Editor
- = T

Fle Edit View Help ‘

S: -740.00 1

o oo

VV e | (© e
Fa Scene Views

4 Transforms

View Controllers

&
[i‘ Load DICOM Dat>.
Dicom/ @) Volume Rendering

To access the Volume 0.0 s
module, browse

Informatics
» The Main Window Registration

through the list of

» Loading and Saving Quantification

Diffusion

modules... Lok r

» Mouse &Keyboard Fitering
Surface Models

» Tutorials & Information Converters
Endoscopy

» Acknowledgment Utiities

...or click on the

volume icon @ ]
in the toolbar

Testing
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f\ PET/CT Visualization and Analysis: Information displayed in
[ “Layers”

(=S

. . - |
sosiicer  Note: this stacks the PET, CT and T T L AT —

0 O, . A | vlresstent | [ Mo & 3 v

VOl in three layers: g o

Background = CT1
Foreground = PET1
Overlay (Label) = PET1-label A

where they can be blended into al
single visualization

3071.00

[ ]

ENEEEEENE =

INEEEEEEEEEEEEEEN

]
|
[ |
]
[ |
|
[ |
|
[ |
|
[ |
|
[ |
|
[ |
|
[ |
[ |
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PET/CT Visualization and Analysis: Adjust display of baseline
study
v

3 DS | I cer & 3D Slicer 40.gamma-2011-11-22 SlE s

File Edit View Help

B Y |vodes: | volumes = QO IO @« 2 9Hd 2 B o | & v persstent Ra Fe,
EEgosy ——— §——————
@& | |ma 2 ? -,
@ 3DSlicer : 100 :l@l?ﬂl-}abel
[ £ [o.00 [=| BB pemt

v[[cn i

> Help & Acknowledgement

Active Volume | GTes

|
\
“F Volume Information |
\

Click on the Visibility| |~
icon &
to display the PET1 image

@® | <r B |Axal = X -
v . . o _ 4 v

. - . @@ # |10 :| &6 | pET 14abel + pEmm—
in the Slice Viewers, |
|u{o.oo 7||PETI R
‘ i r I c - B |cm “ - ;

¥ Data Probe
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@ PET/CT Visualization and Analysis: Adjust display of baseline
W» study

3 DS I | cer @ 3D Slicer 4.0.gamma-2011-11-22
File Edit View Help

Adjust the level for~  ——
. B @ L i jae 3
PET1 volume to jointly|...

: ; ..' & | |2 | B | peT1dabel <

display the datasets TASL MEr I R

the foregroundand| - ¢ . [ g/ N
background layers. o
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ﬁi\ PET/CT Visualization and Analysis: Adjust display of baseline

»” study

3DSlicer

Choose PET1 as
Active Volume

In the Display Panel,
choose a colorization
option for the PET
volume from among
Heat, Rainbow or
MPI.

& 3D Slicer 4.0.gamma-2011-11-23

(=

RSNA 2011

Fle Edit View Hep

R & Modules: @ Volumes
‘5‘ 3DSlicer

| Red RAS: (334.9, 308.8, -740.0) Axial Sp: 5.0

L PET1-label (1, 53,98)  Black (0)
F PET
BCT1 (87, 128, 95) Out of Frame

ne RAS: (125.0, -125.0, 1.0),

= Q.
@® R

QQ%K\@Z/%GQV pesstent | [l R Fa e
s: 7

40.00 i
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&

PET/CT Visualization and Analysis: Explore the visualization

3DSlicer

Explore: |
in the Slice Viewers, scroll
through the slices to
locate the green Tumor
label and the yellow Liver

label.

Note: (the yellow label is
used only to demonstrate
multiple-VOI functionality).

RSNA 2011

@ 3D Slicer 4.0.gamma-2011-11-22

File Edit View Help

play
tookpTabe: [ o
Interpol late:
Lev

ey 3
;W
Window Level editor presets:
=l |
L <
\ - J
Wi 350 (5 |Manual WL I =

=
Al _w—_ » & z e [ 2 T .
= = —aS—tr—ts i O g v | Persistent 5
7% R s:-825.00 | #1
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PET/CT Visualization and Analysis: Compute SUV for all

[ . .
N = VOlIls in baseline
3DSlicer ‘g;“& d‘. = A" QO IR ® @ A §E 2 [H|o t s B K|+~ ‘
B~

Using the Module
Menubutton, expose
the menu and select
SUV computation
under the
Quantification
category
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PET/CT Visualization and Analysis: Compute SUV for all

.ﬁ

3DSlicer

In Image and
Information, select the

PET and VOI volume
(for example PET1 and

PET1-label)

RSNA 2011

VOlIls in baseline

r
& 3D Slicer 4.0.gamma-2011-11-23

==

File Edit View Help

SSSSSSSS

L4
» Help & Acknowled
- mputation

rameter set: | SUVComputal

tatus
v Im d Inform
PET DICOM volume p/jth C: /Users/BIDMCvostro/Documents|Slicer/data/PE

£T Volu ET1
folu ET 1abel

‘{DQ‘%X\@Z/EOtvwmsmm

) 30 R S: -740.00 1
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PET/CT Visualization and Analysis: Compute SUV for all

\ 4
3DSlicer

PET DICOM
volume path:
Input the path to a
directory
containing a
DICOM header
with information
for SUV
computation

RSNA 2011

VOlIls in baseline

£ 3D Slicer 40.gamma-2011-11-23

Fie Edt View Hep

D B Modues: SUVComputation

Input PET Volume PET1

Input VOI Volume PET 14abel

¥ Output

Output (csv

‘Select Slicer_data 2011

Output Lab
Output Lab

SUV Max Select Folder ] [ Cancel

SUV Mean

o Select the PETCTfusion-TutorialData
= directory

i And select the folder: PET1

— double click the folder, or click Select!
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PET/CT Visualization and Analysis: Compute SUV for all

ﬁ VOlIls in baseline

[ 3D Slicer 4.0.gamma-2011-11-23

(=] & i)

3DSlicer Fie Edit View Help

sy Py . "
= 5 Modules: SUVComputation

E OSlicer

» Help & Acknowledgement
¥ SUVComputation
Parameter set: | SUVComputation1

Status

v Image and Information

Input PET Volume PET1
Input VOI Volume PET 14abel
¥ Output

Output (csv) file

Output Label

Output Label Value

To start the SUV ™
computation, click
Apply

PET DICOM volume path C:/Users/BIDMCvostro/Documents/Slicer data/PE

RSNA 2011
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™ PET/CT Visualization and Analysis: Compute SUV for all
Q VOIs in baseline

3DSlicer

SUVmax,
SUVmean and
SUVmin for each
VOI (represented
by a different
color in the label
map) are
displayed.

RSNA 2011

800 3D Slicer 4.0.gamma-2011-11-25

%2 B | Modules: . | SUVComputation = QO > @ @« A @ d 2 ﬁ & b v pesisent | [
@®

rb\ 3DSlicer

4

| > Help & Acknowledgement
| v suvComputation
Parameter set: | SUVComputationt

Status Completed
PIIFIFIIFIIFIIFI I T I I T I I FFFFFFFFFFFFFFT, v

| v Image and Information

PET DICOM volume path 9 U

data/PETCTFusion-TutorialData/PET1

Input PET Volume PET1

Input VOI Volume PET1-label

| v Output

Output (csv) file
Output Label Tumor, fMRI-low
Output Label Value 6, 8

SUV Max 8.01905, 3.63891
SUV Mean 2.41028, 2.87096
SUV Minimum 0631093, 1.98854
|  Default Cancel Apply
| v Data Probe
L
F
B

None RAS: (125.0,-125.0, 1.0),
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c: PET/CT Visualization and Analysis: Compute SUV for
‘ foll
= ollow-up study

3DSlicer

LOOk fOr response to @ 3DSlicer
treatment in the follow-up o & Aswowesgemen
StU dy: ¥ SUVComputation

Parameter set: | SUVComputation1 -

Status Completed

In the Image and ——

I n fo rm ati on pa ne I y S et . PET DICOM volume path | 55 jUsersivaleriehumblet/Documents/RSNA2011/Siicer/Siicer_data/PETCTFusion-TutorialData/PET2
PET DICOM= PET2, o (e

PET volume = PET2 and Zoms

VO I VOI u m e - P ET2 -I a be I . Output Label Tumor, fMRI-low

Output Label Value |6, 8

This dataset contains two e
VOls that correspond to
the segmentations the

baseline study. o
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| @ PET/CT Visualization and Analysis: Assess response
N=”

3DSlicer

Pre-Treatment Max SUVbw = 8.0 g/ml

Post-Treatment Max SUVbw = 9.4 g/ml
+16.61%

(Stable
Disease)
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@ ChangeTracker: exploring small volumetric changes
v

3DSlicer

Part lll: Analyzing Small
Volumetric Changes

using the Change Tracker
Module

Kilian M Pohl, PhD
Ender Konukoglu, PhD
Andriy Fedorov, PhD

The module described in this tutorial was tested on Axial 3D
SPGR T1 post Gadolinium scans (Voxel dimension: 0.94mm x
0.94mm x 1.20mm, FOV: 240mm, Matrix: 256 x 256)
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| ChangeTracker: Conventional measures of tumor response
Q y

3DSlicer

- Conventional anatomic imaging using CT or MRI are often
used to evaluate tumor size and shape

« Most clinical trials that evaluate new chemotherapeutic
drugs use changes in uni-dimensional or bi-dimensional
measurements to assess response (e.g. RECIST)

« Slicer has several tools for applying RECIST
methodologies
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Quantifying tumor change: Conventional measures of tumor
response

ii.

(—a
-

a

3DSlicer

le EOt View Window Hep Feedack

BE - ~ - EEEE

3D Slicer’ s Fiducials Module’ -
can be used to measure the ..

longest dlameteru T B
H N E O |
in a tumor cross section. 5 S

[*] Lm 0700 | 470995

-

BoEeERRbeEr=Em 5 e @ A

licer

Two fiducials may be used to
mark the tumor’ s extent.

UselD

* Manigulate Sice Views

EEDDEREER @

wwwww ate 30 View

The distance measurement . U%Eﬁ N
[22] (@] =

(mm) between fiducials will be
updated in the Fiducial’ s GUI. :
Slide 58




’ Quantifying tumor change: Conventional measures of
@ tumor response

le Eot View Wintow ep  Fee

BE [ —— - EOEE— BEEeENUrSEEEE & i -3
4

3DSlicer

3D Slicer’ s Measurements module,
provides interactive measurement -
tools that operate in the 3D Viewer -
and the Slice Viewers. . ... .

Dwspia

=
Sand

¥ Ancle Mdoat

Interactive ruler can be used

to measure the longest " *

diameter and provides-
numerical annotations

€263, 741 Bg 3621.0 O
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Quantifying tumor change: Conventional measures of
tumor response

3DSlicer

3D Slicer’s
LabelDiameterEstimation
(extension) module will
automatically compute the
largest tumor diameter and
orthogonal dimension.

This analysis requires an
initial segmentation (VOI). LD =381mm

Baseline: June 2006 Follow-up: June 2007
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@ ChangeTracker: rationale for new approaches

3DSlicer

- However, more accurate and precise methods for
understanding volume changes may be useful when:

- benign tumor change is being monitored, or

- where small changes may be clinically significant but
difficult to assess with RECIST

- ChangeTracker Module is a tool to measure
volumetric change at the voxel level.
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@ ChangeTracker: Load the dataset

e 3D Slicer 40.gamma-2011-11-14
3DSlicer ——
: . @B # |vodses:  [weometosir  |3)
Click on the Load Scene icon
Welcome
@LoadData

Select Slicer_data 2011 ™™

Select the ChangeTracker2011 directory, g .. oo s 009 HO
And select the scene file:]
ChangetrackerTutorial2011.mrml|
double click the file, or click Open

» Data Probe Fie name: | |
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,@ ChangeTracker: about the data...

3DSlicer

This course is built upon two scans of a patient with meningioma:

MR Scan 1 MR Scan 2

Please note: we have pre-adjusted the window and level settings for these
volumes so that they are appropriate for display on most laptops. If display is
not satisfactory on your machine or projector, the Volumes Module may be
used to refine these settings.
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@ ChangeTracker: Clinical context

3DSlicer Meningioma
* Usually benign slow-growing tumors

Baseline radiologist’ s clinical impression:

* large falcine lesion is identified.

* measures 3.1 cm anteroposteriorly, 3.05 cm from
side-to-side, 3.5 cm in height.

* enhances moderately on post gadolinium imaging.

SCAN1
Baseline:
June 2006

Follow-up radiologist’ s clinical impression:

* left frontal lobe mass appears unchanged on all series.
* measures 3.3 x 3.2 cm in maximum dimension.

* enhances moderately on post gadolinium imaging.

SCAN2
Follow-up:
June 2007

How has the tumor changed?
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@ ChangeTracker: exploring small volumetric changes

» 3D Slicer 40.gamma-2011-11-14 O | L je—ec—y
3DSlicer ile Edit View Help
SR B [ Modules: @ Models sl == Q . oD % A @ Z] 7 EH | 4 v Persistent e 5o -
1 s: 0.00 1

All Modules ' ER

£ Annotations
{‘D WSlicer DICOM
4 A, Data
/. Editor
¥ Help & Acknowledgement @ Models

Ha Scene Views

Using the Modules Menu __ N

View Controllers

@ volume Rendering

button, ® wime

Welcome to Slicer

Select the T ==
ChangeTracker Module -~ - :

Segmentation

" A: 0.00

R: 0.00 G

=Y
Quantification

from the Wizards —_—

IGT

>
C ateg ory Fittering .
- Surface Models 4 -
— | Converters 4 "
e \

Endoscopy
Utilities

- P Developer Tools
L] Pre Legacy

¥ Data Probe Testing
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; ChangeTracker: a note about the Workflow wizard
-

3DSlicer

A Workflow Wizard
guides the user through a
sequence of steps and has
the following components:

* the Step Panel
* the User Panel
* the Navigation Panel

RSNA 2011

Step Panel--

User Panel--

Navigation
Panel--

@ 3DSlicer

» Help & Acknowledgement

¥ 1, Selectinput scans

Select the baseline and follow-up scans to be compared.

Load test data

Baseline scan: | Select a Volume

Followup scan: | Select a Volume

O O

| O

¥ Data Probe
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@ ChangeTracker: First step: select scans
w

@ 3D Slicer 4.0.gamma-2011-11-14

3DSlicer

File Edit View Help

®
®

{a 3DSlicer

L

P Help & Acknowledgement

¥ 1 Gelactinnut crane

select the baseline and follow-up scans to be compared.

Load test data
Baseline scan: | 2006-spgr.nrrd

Followup scan: | 2007-spgr.nrrd

Y

¥ Data Probe

Click on Next

G2 % [Moddes: [ ChangeTracker = Q_ QIO @« A §& ~
5 R

Scan 1 = 2006-spgr

Select baseline & follow-up studies:

RSNA 2011
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@ ChangeTracker: inspect the tumor
4

3DSlicer

Move sliders in Slice
Viewer Control panels to
get a close-up view of
tumor in Axial, Sagittal
and Coronal slice
viewers.

Zoom (Right mouse
down and push/pull).

Pan (Middle mouse down
and move)

& 3D Slicer 40.gamma-2011-11-14

File Edit View Help

R B |Modes:

!U= 30Slicer
vy

» Help & Acknowledgement

¥ 2. Define Region of Interest

Define ROI that covers the object of interest.

Select ROI: | vtkMRMLAnnotationROINode 1 2]
Define VOI

LR Range: ‘

-10.00 = 10.00 %{‘ -

P-ARange: T
N9 10,00 [4]

10.00 %{‘ =]
80—

FSRange: 500 [2) 10.00 ﬂ‘ =

5 | Dispay Cipping box ¥ Interactive Mode

(€] )

RSNA 2011

¥ Data Probe

| Red RAS: (39.1, 12.0, 30.8) Axial Sp: 1.4

L None 0
F 2007-spgr.nrrd (35, 115, 90) 113
B 2006-spgr.nrrd (86, 115, 78) 83

ChangeTracker DR CESHEAN“IK "I B Al ;‘ t v lressent | @ Am R | b

e — S —
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@ ChangeTracker: Step 2: Define a volume of interest

{ & 3D Slicer 4.0.gamma-2011-11-18 o | B |

st A'VOI Box Widget is positioned within the image volume in the 3D
viewer
R4
LR Range: 10.57 : O:. 16.55 : ;
Center the VOI first: | ..

Position the square in the
center of the tumor in the
slice viewer.

, 30.8) Axial Sp: 1.4

L None 0
F 2007-spgr.nrrd (170, 128, 90) 147
B 2006-spgr.nrrd (170, 128, 78) 83
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\ ChangeTracker: Step 2: Define a volume of interest
-

[ /5 3D Slicer 40.gamma-2011-11-18

3DSlicer

| B [ )

View the VOI box widget
and volume rendering of

tumor in yellow in the 3D!
Viewer

F'O'O'QO%{(\WE/ E;tv resstent | @ R S

® R s:32.20 ¥ 1

Next, resize the VOI.:

Use the colored handles
to change the VOI extent

v

RSNA 2011
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// ”" 5

3DSlicer

ChangeTracker: Step 2: Define a volume of interest

Fine-tune the VOI using the VOI Widget range sliders
or by moving the VOI Widget handles in 3D view

¥ 2, Define Region of Interest |

1

’ Define ROI that covers the object of interest.

SelectROL: | vkMRMLAnOtationROINode1 .~ & |

Define VOI

L-R Range: )
9% [ 20,99 - 1510 |3

:

:B [:EH

9 |Display Clipping box | Interactive Mode

HHLEI

AN

Note: VOI Widget range sliders are color-coded to
match VOI box Widget handles in 3D Viewer
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@ ChangeTracker: Step 2: Define a volume of interest
4

3DSlicer

Scroll through slices
to ensure that tumor
boundaries are
included in the VOI.

Click Next

RSNA 2011

r
& 3D Slicer 4.0.gamma-2011-11-18

T G——

» Help & Acknowledgement

¥ 2. Define Region of Interest

Define ROI that covers the object of interest,

Define VOI
L-R Range:

2126 [ |65 |2 =
ﬁ_
P-ARange: = =
711 (= |a7.91 3
— g—g
ISRange: [~ Ta r—y
891 | [s0.55 [3] -

# | Display Clipping box ¥! Interactive Mode

€] Q

Select ROI: | vtkMRMLANNotationROINode 1 s

L] 'g

¥ Data Probe

Yellow RAS: (0.9, 37.6, -13.9) Sagittal Sp: 0.9
L None 0

F 2007-spgr.nrrd (129, 87, 53) 128
8 2006-spgr.nrrd (129, 87, 46) 23

)

(=B ]
Fle Edt View Help
j‘\? ) [ Modules: ChangeTracker 4| . - c. a4 : ot E G pmpersstent | @ Sw &. -
o= —
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\ ChangeTracker: Step 2: Define a volume of interest
4

3DSlicer

eeeeeeeeee

You should see a volume called
a Baseline ROl selected in the
background layer

...and...

a BaselineROIl_segmentation1
selected in the label layer.

RSNA 2011 Slide 73




\@ ChangeTracker: Step 3: Segment the tumor
A

@ 3D Slicer 40.gamma-2011-11-18 :
3DSlicer Fie Edit View Help - 3D Vlewer ShOWS
R ks [ 2™ Q QIO @ AP E 2 HO) b e B Ao
B £

-.model of tumor

Modify the
segmentation by
moving threshold,  ,
range slider

Slice Viewers show
VOI with current
segmentation
overlay in light

yellow

’
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\ ChangeTracker: Step 3: Segment the tumor
N

r .
[ 3D Slicer 4.0.gamma-2011-11-18 S | & S|
3DSlicer Fle at vew b

‘;\"“3’ 5 Modules: ChangeTracker s -V 3 OV {D (48] G A @ E 7. B%' o t v || Persistent =™ A%v

Scroll through =
. . B soslicer
the slices until the -

segmentation ==
appears optimal.

()]
®
o

v Basic settings

Choose threshold: [ 354 =) |330 |5

» Advanced settings

Press Next.}

(€] Q

¥ Data Probe

| Red RAS: (28.0,22.9,29.5) Axial 5p: 0.5

L baselineROI_segmentation1 (104, 33, 44) Out of Frame
F None

0
B baselineROI (104, 33, 44) Out of Frame
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@ ChangeTracker: Final step: Select Metric

3DSlicer

Select fast and

press Next

RSNA 2011

& 3D Slicer 40.gamma-2011-11-18

Metric Options:

G # [moddes: [ ChangeTradker = Q00N O @ A §HE 2 |H|e|t -

@ 3DSlicer

» Help & Acknowledgement

Detect change by
analyzing intensity
pattern (fast)

v 4,ROI Analysis

Select the analysis method for the selected ROL.

ST —
| Intensity Difference Change Detection (FAST)

P Advanced settings

Measure change by

analyzing
deformation map
(slow)
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\ ChangeTracker: Results: change in pathology
-

3DSlicer { [ 3D Slicer 40.gamma-2011-11-18 = E [

Change in volume is shown === =00 8¢« : ¢4 &t~ -—
overlaying the tumor image

and in the 3D Viewer:
magenta = growth
green = shrinkage S

Note: Analysis is
displayed in the
“Compare View” — o
layout with linked

control for the €
compare Viewers.
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@ ChangeTracker:
y

Results: change in pathology

. & 3D Slicer 4.0.gamma-2011-11-18
3DSlicer =

File Edit View Help

G2 By |Moddes: [ ChangeTracker

! !‘; 3DSlicer
4

dIm Q0 OIN® e A9 @ 2 EL\o\tvvne
lgckﬁ__ 27.98|#1 1
R

B

|l B 9
‘ @ ! iz ‘b selineROI_segmentation2

@ ?|0,00 %{ B ‘None

¥ Help & Acknowledgement

‘E‘ il :|| baselineROI

¥ 5. ROI Analysis Results

Select visibility icon |
to show axial slice in the
3D Viewer.

IntensityDifferenceMedic |

Cmﬂ’"’\'i 1.40'mL (13845 pixels), or 0.88%

e: 0.00 mL (0 pixels), or 0.00%

3 mL (13845 pixels), or 0.88%

¥ Data Probe

n

RSNA 2011
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@ ChangeTracker: Results: change in pathology
y

3DSlicer

“Compare View” layout
displays:

*Axial slice & 3D View
*Five corresponding
consecutive slices for the

VOI in Scan1 (top row), and

*in the Scan2 (bottom row).

RSNA 2011
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@ ChangeTracker: Results: change in pathology
4

IpSlicer Crosshairs in Compare View show corresponding
voxels in Scan1 and Scan2 for voxel-wise comparison.
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3DSlicer

ChangeTracker: Exploring small volumetric changes

Tested on Axial 3D SPGR T1 post Gadolinium scans (Voxel dimension:
0.94mm x 0.94mm x 1.20mm, FOV: 240mm, Matrix: 256 x 256).

Tumor boundary should be clear.

Only for contrast enhanced images.

Need homogenous enhancement across time points.
Not tested for tumors with changing necrosis.

Correspondence between Intensity-based and deformation mapping-
based analyses should be checked.
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@ ChangeTracker: Exploring small volumetric changes
v

3DSlicer

This tutorial demonstrated:

* a method to quantify small volumetric changes in pathology.
* visualization of these changes in the anatomical context

* use of Slicer’ s “Compare Viewer” to simultaneously explore
baseline and follow-up studies.
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\ Clear the scene and its data

3DSlicer

& 3D Slicer 40.gamma-2011-11-14

Clear the previous scene.

Select File->Close Scene

This removes any datasets

previously loaded into Slicer. -=
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/& Workshop summary
R This workshop has demonstrated:

* Basic scene loading and visualization using 3D Slicer

* Workflow to make quantitative measurements of SUV
(body weight) in Slicer

* Use of Slicer’ s ChangeTracker module to assess small
changes in tumor size
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\ Thank you and more information

3DSlicer

 Thank you for your attendance!

« Tutorial Slides and Data:
www.na-mic.org/Wiki/index.php/RSNA 2011

« Tutorial Software:
www.slicer.org/Downloads

*  More Information: http://www.slicer.org
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